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About This Guide
This user’s guide describes how to install and use BD™ Cytometric Bead Array
(BD CBA) software for analysis. For information regarding the beads and data
acquisition methods, refer to the appropriate data sheet.

First-time users of the software should read Chapter 1 to learn about its features
and how to install and start up the software. Instructions for routine users can be
found in Chapter 2 and Chapter 3. For troubleshooting, see Chapter 4.

Conventions

The following conventions are used throughout this guide.

Table 1 Notice icons

Icon Notice Type Description

NOTE Describes important features or instructions.

CAUTION Alerts you to potential loss of data or potential damage to
an application, system, or device.

WARNING Alerts you to potential personal injury.

Tip Highlights features or hints that can save time and prevent
difficulties.

NOTE Screen captures in this book were made on a PC computer running
BD CBA software version 1.4 with Microsoft® Excel 2000, unless otherwise noted.
Screen appearance might differ for other versions of BD CBA software and Excel,
but the functionality is the same.
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Technical Assistance

If you have technical questions or need assistance in solving a problem, try the
following:

• Reread the section of the user’s guide specific to the operation you are
performing.

• See Chapter 4.

• Visit our website at www.bdbiosciences.com/pharmingen/CBA/ for notices,
technical bulletins, and troubleshooting tips.

• If additional assistance is required, contact your local BD Biosciences service
representative or supplier.

Table 2 Text conventions

Convention Use

Italics New or unfamiliar terms are listed in italics on their first appearance in
the text.

> The arrow indicates a menu choice. For example, “choose File > Print”
means to choose Print from the File menu.

Command-X Keyboard shortcuts use the Command key () in combination with
another indicated keystroke. For example, Command-K means to hold
down the Command key while pressing the letter k.
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About This Guide

When contacting BD Biosciences, have the following information available:

- software version numbers

- any error messages

- details of recent software performance

For instrument support from within the US, call (877) 232-8995, prompt #2-2.

For support from within Canada, call (888) 259-0187.

For all other countries, contact your local BD Biosciences representative.
Refer to our website, www.bdbiosciences.com, for up-to-date contact information.
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1

Introduction
The following topics are covered in this section:

• BD Cytometric Bead Array (BD CBA)

• System Requirements

• Installation

• Using BD CBA Software

9
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BD Cytometric Bead Array

The BD CBA system was created to provide a customer-friendly platform for
performing multiplex assays. The system includes reagents, hardware, and
software.

Multiplex assays are bead-based flow cytometric immunoassays that can detect
multiple analytes in a single sample. Discrimination of the bead-bound analyte is
accomplished by flow cytometry using beads that have various sizes or that are
labeled with varying levels of fluorochrome. The samples are acquired using
general-purpose flow cytometry software such as BD CellQuest™ software.

The data files are analyzed using BD CBA calibration and analysis software,
which is written in the Microsoft Excel Visual Basic for Applications (VBA)
programming language. Because Excel 98, Excel 2001, Excel X (Mac®),
Excel 2000 and Excel XP (Windows®)  differ in how they handle add-ins
and help text, separate versions of the BD CBA application exist for use with 
each of these versions of Excel.

The BD CBA application is in the form of Excel workbooks that contain the
worksheets, dialog sheets, workbook-specific code, and BD CBA Add-In file
(which contains the compiled VBA code).

Depending on the assay chosen, the software will either provide a quantitative
estimate of analyte concentration for assays of eight beads or fewer, or will give a
qualitative, positive/negative analysis for mouse isotyping assays based on a user-
defined cutoff value.

Quantitative Analysis
Quantitative analysis is used to determine the analyte concentration in a sample
file based on known concentration values in a set of standards. BD CBA software
provides quantitative analysis for up to eight analytes (beads) per sample file.
There can be up to 20 calibration (concentration) levels for the standards, each
with up to five replicates. Each concentration level must have the same number of
replicates.

10



Chapter 1: Introduction

To perform quantitative analysis, you must acquire (eg, using BD CellQuest
or BD FACSArray software) standards of known concentration for each analyte, 
prepared by serial dilution of a bulk concentrate.

The BD CBA software reads the resulting FCS file, gates the population on
forward and side scatter (FSC and SSC), then draws an FL3 histogram. Each of
the identified peaks in the FL3 histogram—one for each analyte-bead complex—is
assigned a Median or Mean Fluorescence Intensity (MFI) value.

The software performs a log transformation of the data, then fits a curve to the
points using either a four-parameter logistic model or a log-log model. You
choose which model to use. The calibration curve can be used to obtain estimated
concentration values for sample files.

Qualitative Analysis
Qualitative analysis is used to determine the specific type of murine
immunoglobulin subclasses found in a sample. Data is acquired using
BD CellQuest software (an Experiment document is provided for convenience).
The FCS data files are analyzed by BD CBA software, which reports MFI values
for FL1 (lambda) and FL2 (kappa) and qualitative (positive or negative) results.

A positive or negative result is reported by determining whether test samples fall
above or below a cutoff value. The cutoff value is the MFI of a blank bead
multiplied by a user-specified negative threshold value (the default value is 3).
BD CBA software provides qualitative analysis for seven beads.

11
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System Requirements

Hardware

• Macintosh PowerPC™, G3, or G4 computer; or PC running Windows 98,
Windows NT 4.0, or Windows 2000

• 64 MB RAM or more

• 2.5 MB free hard disk space

• 16-inch monitor or larger

Software

• Mac OS version 8.1, 8.6, or 9, or X; Windows 98, Windows NT
(32-bit) version 4.0, or Windows 2000; BD FACSConvert software

• Microsoft Excel with the Solver Add-In: Excel 98, Excel 2001,
or Excel X for Macintosh; Excel 2000 or Excel XP for Windows

CAUTION You might have to custom install the Solver Add-In from your
Microsoft Excel installation CD or disks if it is not part of the standard
installation. Instructions for installing the add-in can be found in the
following section.

• BD FACSComp™ software

Files

• Flow Cytometry Standard (FCS) 2.0 or 3.0 files

12
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Installation

Have the following on hand before beginning installation:

• Microsoft Office installation CD

• BD CBA installation CD

• software registration number (found on the Product Registration Card in
the user’s guide)

Installing the Solver Add-In
To use BD CBA software, you will need a complete version of Microsoft Excel
including the Solver Add-In. You can install these files from your Microsoft Excel
installation CD or disks.

1 Insert the Microsoft Office CD into the CD-ROM drive.

2 Locate the installer for Excel Add-ins.

The type of installer varies depending on your version of Excel. For
example, in Excel 98, you use the Value Pack Installer to add other options
(Figure 1-1 on page 14).

13
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Figure 1-1 Installing the Solver Add-in from the Value Pack Installer (Excel 98)

3 Select and install the Solver Add-in.

The add-in is installed in the appropriate location.

• Excel 98—Microsoft Office 98:Office:Excel Add-ins

• Excel 2001—Microsoft Office 2001: Office:Add-ins

• Excel X—Microsoft Office X:Office:Add-ins

• Excel 2000—Microsoft Office:Office:Library

• Excel XP—Microsoft Office:Office:Library

14
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Upgrading BD CBA Software
If you have a previous version of BD CBA software installed on your computer,
you should uninstall it before installing the new software.

1 Insert the BD CBA CD into the CD-ROM drive.

2 Double-click the BD CBA Uninstaller icon.

3 One or more messages appear on your screen as the uninstaller removes the
previous version of BD CBA software. A completion message displays when the
process is finished.

4 Follow the Instructions for installing BD CBA software.

Figure 1-2 Uninstalling the BD CBA Software (Macintosh)
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Installing BD CBA Software
Before installing BD CBA software, install Excel. When you install BD CBA
software you will be asked to select the version of Excel that is installed on your
system.

CAUTION The BD CBA Installer installs several files on your computer. Do not
rename the files or the application will not function.

1 Insert the BD CBA CD into the CD-ROM drive.

2 Double-click the BD CBA Installer icon.

3 Follow the directions on the screen.

4 When prompted, enter the password from the Product Registration Card.

The BD CBA installer adds the appropriate files to the BD Applications folder
and the Microsoft Office folder (Figure 1-2).

CAUTION To run the software, the BD Applications folder and the Microsoft
Office folder must be in the same disk partition on the hard disk.

Figure 1-3 BD Applications and Office folder contents

16
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Increasing Memory Allocation
After installation is complete, follow these steps to allocate at least 12 MB RAM
to the Microsoft Excel application.

NOTE This is not necessary if you are using a PC or a Mac with OS X.
You cannot do this while Microsoft Excel is open.

1 Quit Microsoft Excel, if open.

2 Select the Microsoft Excel application icon.

3 Choose Get Info from the File menu (-I).

The BD CBA Info dialog box appears.

4 Change the Preferred and Minimum RAM allocations to 12288 K each.

• For MacOS 8.1, the Minimum Size and Preferred Size fields are found
in the Memory Requirements area at the bottom right of the Get Info box.

• For MacOS 8.6 and 9, choose Memory from the Show pop-up menu
and increase the numbers in the Minimum Size and Preferred Size fields
in the Memory Requirements area.

5 Close the Get Info dialog box.

17
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Using BD CBA Software

The BD CBA application folder contains workbooks for
quantitative analysis and qualitative analysis.

• Use the BD CBA 4Bead Analysis, BD CBA 6Bead Analysis,
and BD CBA 8Bead Analysis workbooks for quantitative
analysis.

Quantitative analysis is described in Chapter 2.

• Use the BD CBA Isotype Analysis workbook for qualitative
analysis.

Qualitative analysis is described in Chapter 3.

Using Regional Settings

BD CBA 1.4 supports international settings for numbers and dates. Set the locale in
the Regional Options window in order to use the standard settings.

Using Regional Settings on Macintosh

1 From the Apple Menu, select Control Panels.

2 Select Numbers and choose a language, such as German or Japanese.

3 Click OK.

18
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Using Regional Settings on Windows

1 Select Start->Select Settings->Control Panels.

2 Select Regional Options.

The Regional Options dialog will display.

Figure 1-4 Regional Options Dialog (Windows)

3 Select a language from the list, such as German or Japanese.

4 Click OK.

19
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2

Quantitative Analysis
The following topics are covered in this section:

• Launching BD CBA Software

• Beginning Analysis

• Setting Up Calibration

• Entering Analyte Labels and Concentration Values

• Calculating Curves

• Analyzing Sample Files

• Reporting Quantitative Results

21
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Launching BD CBA Software

The BD CBA 4Bead Analysis, BD CBA 6Bead Analysis, and BD CBA 8Bead
Analysis workbooks are used for quantitative analysis.

Number of Beads Workbook to Use Icon

1–4 BD CBA 4Bead Analysis

5 or 6 BD CBA 6Bead Analysis

7 or 8 BD CBA 8Bead Analysis

1 Double-click the applicable Microsoft Excel workbook icon.

Microsoft Excel software will launch. A dialog box might appear to alert you
that the document contains macros.

2 If the dialog box appears, click the Enable Macros button.

BD CBA software will launch and the home screen for the chosen workbook
appears (Figure 2-1 on page 23).

22



Chapter 2: Quantitative Analysis

Figure 2-1 4Bead, 6Bead, and 8Bead Analysis home screens
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Beginning Analysis

1 Select the appropriate number of beads on the BD CBA home screen.

2 Click Analyze.

The Quantitative toolbar and a blank RawData worksheet appear
(Figure 2-2).

Figure 2-2 Quantitative toolbar and RawData worksheet

NOTE In Microsoft Excel software, the name of the active worksheet
appears as a tab at the bottom of the window.

The toolbar appears free-floating. You can move it or drag it to the toolbar
area above the worksheet. Figure 2-3 and Table 2-1 on page 25 describe
the functions of the buttons on the toolbar.

24
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Figure 2-3 BD CBA Quant Analysis toolbar

Table 2-1 Quantitative toolbar buttons

Get Calib Files—displays the Calibration Setup dialog, prompts
you to identify the calibration files, and copies the filenames to
the workbook.

Enter Concentrations—displays a dialog box in which you enter
analyte concentration values and labels.

Calculate MFIs—automatically calculates mean fluorescence
intensities (MFIs) for all files and analytes.

Generate Standard Curves—prompts you to select a curve-fitting
model, and generates standard curves.

Analyze Sample Files—prompts you to identify the sample files,
and calculates MFIs and concentrations.

Print Reports—displays a dialog box in which you select the
reports to print.

Save Reports—displays a dialog box in which you select the
reports to save.

Home Screen—returns to the home screen.

Help—displays online help for Quantitative analysis.

Zoom box—magnifies or zooms in on a worksheet to the level selected.

25
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Setting Up Calibration

Entering Calibration Information

1 Click the Get Calib Files button (     ) on the Quantitative toolbar.

The Calibration Setup dialog box appears.

2 Use the information in the following sections to enter the necessary
information

User Information

• Institution—name of your institution

• Experiment —name of the experiment

• Director—lab director’s name

• Operator—flow cytometer operator’s name

26
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Format

• Tubes— data is acquired from tubes

• BD FACSArray 96-Well Plate — one or more 96-well plates are acquired with
BD FACSArray acquisition software

• BD MAS/MPM 96-Well Plate— one or more 96-well plates are acquired with
BD MAS/MPM and CellQuest acquisition software

• Plates — number of plates in the experiment. BD CBA software supports up to
five plates per experiment.

Reporter Antibody

• Fluorescence—the fluorescence parameter used to label the detector antibodies.
MFIs are calculated using this fluorescence parameter. Select FL1 or FL2.

• MFI—method used to calculate MFI. Determine which is most appropriate for
your analysis. Refer to your BD CellQuest software user’s guide for more
information.

Parameter Map

Select the parameter order in which the instrument acquired and saved the data. For
example, if the instrument saved data in the following order: FSC, SSC, FL2, and
FL1, select P1 for FSC, P2 for SSC, P3 for FL2, and P4 for FL1.

NOTE If you are not sure of the parameter order, you can open the FCS file in
Excel. The parameters are listed in the order in which they were acquired and saved.
Refer to Reading the FCS File Header on page 89 for more information.

Click Use Defaults to set the values to the BD default values (P1, P2, P3, P4, P5).
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Beads & Analytes

• Beads in Mix—the total number of analytes in the mix. This value matches the
assay selected on the home screen; it is preset and cannot be edited.

• BD CBA Kit— the kit used in this experiment. Up to ten kits can be predefined
on the Preferences worksheet. The software automatically labels all charts and
data columns with the appropriate analyte names based on the kit you select.

• Bead Sizes—number of bead sizes. The same number of Analytes Per Bead Size
pop-up menus are active.

NOTE The initial product release from BD Biosciences will have only one bead
size. Subsequent product configurations might include several bead sizes.

• Number of Standard Replicates—the number of replicates used to generate the
standard curves. Use up to five replicates. Each calibration level (concentration)
must have the same number of replicates.

• Analytes Per Bead Size—the number of analytes for each bead size. Size 1 rep-
resents the smallest bead; size 5 represents the largest. You can analyze a total
of eight analytes with five bead sizes depending on the assay selected.
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For example, if you have a 4-bead assay with three bead sizes, you could have the
following Analytes Per Bead Size configurations.

Example 1 Example 2 Example 3

Size 1: 2 Size 1: 1 Size 1: 1

Size 2: 1 Size 2: 2 Size 2: 1

Size 3: 1 Size 3: 1 Size 3: 2

If you have a 6-bead assay with four bead sizes, you could have one of the follow-
ing Analytes Per Bead Size configurations.

NOTE Not all configurations are shown.

Example 1 Example 2 Example 3 Example 4

Size 1: 1 Size 1: 1 Size 1: 2 Size 1: 2

Size 2: 1 Size 2: 2 Size 2: 1 Size 2: 2

Size 3: 2 Size 3: 2 Size 3: 1 Size 3: 1

Size 4: 2 Size 4: 1 Size 4: 2 Size 4: 1

Lot Information

Refer to the reagent label or kit box for the Lot ID and Expiration Date.

NOTE Each time you use the workbook, you will have to reenter these values
unless you save the workbook as a template (see page 63).

Curve Fitting Model

• 4-Parameter Logistic—fits the best non-linear curve to the data points after the
MFIs are calculated

• Log-Log—fits the best straight line to the data points on a logarithmic scale
after the MFIs are calculated

• Neither—does not apply a curve-fitting model initially
To apply a curve-fitting model, click the Generate Standard Curves button
on the toolbar.
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Identifying Calibration Files
Each time you run BD CBA software, the RawData worksheet will be blank. You
must locate and define a set of calibration files to begin analysis. Files are listed on
the RawData worksheet in the order by which they are named. The software sorts
the files by concentration value when it calculates the MFIs.

NOTE Name the files such that the concentration values are always ordered from
lowest concentration to highest. Follow the naming convention described in the data
sheet. Alternatively, to order the files, add a numeric prefix to each file. Numbers
are sorted in the following manner: 1, 10, 2, 3…8, 9; and 01, 02, 03…08, 09, 10.
In Figure 2-4, the numeric prefix of each file name ensures that the files are ordered
from lowest to highest concentration.

1 Click OK in the Calibration Setup dialog box.

A dialog box appears (Figure 2-4 or Figure 2-5).

Figure 2-4 Example file order (Mac)
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Figure 2-5 Example file order (Windows)

2 Locate the folder containing your calibration files.

All files in the folder will be analyzed. Folders must contain the following:

• a zero calibrator

• only Flow Cytometry Standard (FCS) version 2.0 or 3.0 calibration files

• files named with at least one alphabetic character in each filename

• for replicates, all files for each replicate

NOTE When using BD CBA with Excel 2001 (Macintosh), identify the folder
by double-clicking the folder icon rather than using the disclosing triangle to
open the folder (see Figure 2-4 on page 30). Otherwise, appropriate files will
not be copied to the RawData worksheet.

NOTE To analyze files on a Macintosh, use BD FACSConvert™ software to
convert data files generated by the BD FACSCount™ instrument or another
manufacturer’s flow cytometer to Macintosh-compatible FCS 2.0 data files.

31



BD Cytometric Bead Array Software User’s Guide

3 Select the first calibration file, then click Open.

BD CBA software copies all the filenames in the selected folder to the RawData
worksheet in the workbook.

The RawData worksheet appears with the filenames and analyte labels.

NOTE When new calibration files are entered, previous sample calculation
results are cleared.

NOTE File names cannot be changed after they are copied onto the worksheet.

Figure 2-6 Example RawData worksheet without concentration and MFI values
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Entering Analyte Labels and Concentration Values

Entering Data

An assay can have up to 20 calibration levels (concentration values), with up to
five replicates each and eight analytes. You can enter data in one of two ways:

• using the Enter Concentration Values dialog box (see page 34)

• using the RawData worksheet directly (see page 40)

Zero Calibrator

The software operates under the assumption that a file arising from a zero
calibrator has been included in the curve-fitting worksheet. If no zero calibrator
has been run, the sample with the lowest concentration is substituted for the
missing zero calibrator, which might produce results contrary to those expected.

CAUTION Absence of the zero calibrator will cause the log-log model to exclude the
sample with the lowest concentration from the computation of the regression line.

Range of Estimated Concentrations

For display purposes, all logistic curves are scaled across the range of concentrations
(0–100,000) in the data. However, estimated concentrations can only be obtained
for sample fluorescence intensities within the range of calibrator intensities or
calculated intensities for calibrator concentrations. This is expressed mathematically
as follows:

Min (FLzero calibrator , fitted FL0) < FLsample < Min (FLhighest calibrator , fitted FLhighest calibrator)

where:

fitted FL = the height of the calculated curve at a given concentration

This ensures that the logistic models are not applied to data that is outside the range
of the data upon which the models are based.
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Reporting Out-of-Range Results

BD CBA software automatically flags all results that fall outside the standard curve
for each analyte. The out-of-range result appears in red and is reported as less than
or equal to the lowest standard value, or greater than the highest standard value.
Additionally, the following message appears in the Comments column: “MFI (2,3)
out of range. Adjust dilution and repeat test.” The values in parentheses are the
index numbers of the analytes that are out of range.

Results are not extrapolated beyond the boundaries of the standard curve.

Using the Enter Concentration Values Dialog Box

1 Click the Enter Concentrations button (     ) on the Quantitative toolbar.

The Enter Concentration Values dialog box appears (Figure 2-7).

Figure 2-7 Enter Concentration Values dialog box
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You can enter specific analyte labels, specify the number of decimal places for
concentrations values, and define the range of concentrations for each analyte.
The values entered for each calibration file are copied to all appropriate work-
sheets in the workbook.

• Copy Across checkbox—when selected, copies the concentration value you
select or enter in the first column across the row

• Clear—clears all fields in the dialog box, including analyte labels

• Edit List—displays a dialog box in which you can edit the concentration
values for each analyte (see Editing Analyte Concentrations below)

2 Change analyte labels in the first row, if needed.

List analytes from dimmest to brightest bead.

3 Change the number of decimal places for concentration values, if needed.

Zero, one, two, or three decimal places can be specified.

4 Choose concentration values from the pull-down menus.

You can also enter a value directly into a field.

5 Click Continue.

If there are more than 20 calibration files, the Enter Concentration Values
dialog box displays them in groups of 20. When you click Continue, the next
group of files is displayed.

For example, if you have five calibration levels, each with five replicates, there
will be 25 files. The first 20 are displayed in the Enter Concentration Values
dialog box when it first appears. When you click Continue, the next five are
displayed.

When you click Continue on the last screen of the Enter Concentration Values
dialog box, the box closes and the concentration values are copied to the
RawData worksheet.

Editing Analyte Concentrations

You can change the range of concentrations that appear in the pull-down menu
for each analyte. It is best to edit these lists before selecting concentration values
for each file.
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1 Click the Edit List button in the Enter Concentration Values dialog box for the
appropriate analyte.

The Edit List dialog box appears (Figure 2-8).

Figure 2-8 Edit List dialog box

2 To add a value, click Add.

3 Enter a new value; then click OK.

4 Repeat steps 2 and 3 until you have added all required values.
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5 To delete a value, select it and click Delete; then click OK.

CAUTION Do not delete the blank value, it is used by BD CBA software.

6 Repeat step 5 until you have deleted all required values.

7 Click Done.

The Edit List dialog box closes, returning you to the Enter Concentration
Values dialog box (Figure 2-7 on page 34).

Using the Preferences Worksheet
The Preferences worksheet provides timesaving features for processing BD CBA
data. You can you predefine concentration values, analyte labels, and parameter
maps and then choose the desired item from a dropdown menu. You can also edit
the color palettes that are used on PlateView sheets for color coding wells based on
concentration values.

Concentration Values

You can enter up to ten sets of concentration values.  The names and values of
these sets can be edited. The first set (Clear) has the special function of clearing
concentration columns on the RawData sheet, so you can’t change it. You can
change the names and values of all other sets, if desired, even if default values are
provided by BD.

The concentration set names (row 2) appear in the dropdown lists on the RawData
sheet.  When you select a name from the list, the associated concentration values are
copied to the sheet.  If you specify replicates, the concentration values are copied
again for each replicate.
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BD CBA Analyte Kit Labels

You can enter up to ten sets of analyte kit labels on this sheet. Some sets may be
predefined by BD, but you can change the names and values, if desired (except for
the Default list in Column B). The names (row 27) appear in the BD CBA Kit drop-
down list on the Calibration Setup dialog. When you select a name from the list,
the associated labels are copied to all sheets in the workbook. The kit name is also
copied to the Immunoassay field in the experiment information section of the
Calib4, Calib6, and Calib8 reports.

NOTE The Macintosh does not support unicode characters. Therefore, Greek 
characters cannot be used in the analyte names.

Parameter Maps

You can enter up to ten parameter maps on the Preferences worksheet. The labels
(row 39) are displayed in the Predefined Maps dropdown on the Calibration Setup
dialog. When you select a map, the parameter dropdowns on the Calibration Setup
dialog are filled in by the software. 

Default values are provided for the FACSCalibur and recommended values are
provided for Coulter XL, BD FACSVantage, BD LSR, BD FACSArray, and
BD FACSCount instruments. You can modify any of these values, except the
“BD Default” values in Column B.
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Color Palette

You can edit the default color palettes for shading the wells on the PlateView sheets.
The first color palette is used for coloring wells depending on the concentration.
The second color palette is used for coloring wells based on the concentration's
deviation from the mean.

To change the color, click a square then select “Autoshape…” from the Format
menu. Select a new Fill Color from the palette and click OK.

NOTE Not all colors work well for filling cells in the spreadsheet. Colors on the
default color palette work best.
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Using the RawData Worksheet
You can enter information only into columns with a gray background on the
worksheet.

1 Change analyte labels in the first row, if needed.

The worksheet lists common analyte labels (IFN-γ, TNF, and so on). Click in
any of the grayed cells to change the analyte name. Enter specific names (up to
20 characters) from dimmest to brightest bead.

2 Enter new units of concentration in the second row, if needed.

NOTE The default is pg/mL.

The new unit labels will be updated automatically in all appropriate locations.

3 Enter concentration values.

• Save time by using the dropdown menus. Select a concentration set from
the list and the software automatically fills In the values. When replicates
are defined for the calibration standard files, concentration values are
copied to the RawData sheet for each replicate. You can specify how these
values are copied using the radio buttons labeled “By Rep” or “By Conc”.  

40



Chapter 2: Quantitative Analysis

- If you select By Rep, the software will copy the first concentration value
<n> number of times, where <n> is the number of replicates. Then it will
copy the next concentration value <n> times, and so on. 

- If you select By Conc, the software will copy the concentration set as a
group <n> number of times, where <n> is the number of replicates. This is
the default value when you first open the workbook.

• When the Copy Across checkbox is selected, the values you enter in
column E are copied  across the row as you type.

• Click Update StdCurves to copy any changes in concentration values to
the Calib and StdCurve worksheets. Use this button only when correcting
errors.

If you enter a concentration value incorrectly and then calculate the MFIs,
return to the RawData worksheet and click this button. The changes will
automatically update the curves without recalculating the MFIs.

Calculating Curves

Calculating the standard curves is a three-step process.

1 Median or Mean Fluorescence Intensity values (MFIs) are calculated.

2 Curves are calculated based on a model you select.

3 The curves are drawn on the calibration charts.

NOTE Make sure you have entered the concentration values before proceeding.

Calculating MFIs

1 Click the Calculate MFIs button (     ) on the Quantitative toolbar.

An alert notifies you that this process might take a few minutes.

2 Click OK.

The MFIs for each file are calculated. If an error occurs, it is noted in the
worksheet and calculation continues with the next file in the list.

41



BD Cytometric Bead Array Software User’s Guide

To calculate the MFIs, BD CBA software

• sorts the files by concentration value

• gates the bead population for each bead size in FSC and SSC

• gates the bead population for each analyte in FL3

• calculates the geometric mean or median for the reporter (FL1 or FL2)

• copies the results to the standard curve reports

• generates curves on standard curve reports using a curve fitting model chosen
in the Calibration Setup dialog box

When all files have been processed, the Calibx worksheet—where x is the number
of analytes—appears (Figure 2-9 on page 43).

An alert notifies you when the process is complete.
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Figure 2-9 Calib6 worksheet before fitted standard curves are calculated
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Generating Standard Curves
Standard cuvres are automatically generated by clicking the Calculate MFI’s button.
Use this button to replot the standard curve, change the curve fitting model,
or change the weighting used to generate the standard curves.

1 Click the Generate Standard Curves button (     ) on the Quantitative toolbar.

The Select a Model dialog box appears.

2 Choose either 4-Parameter Logistic or Log-Log.

• 4-Parameter Logistic—fits the best non-linear curve to the data points

• Log-Log—fits the best straight line to the data points on a logarithmic
scale

3 Click OK.

Curves are plotted for each analyte. The Calibx worksheet is displayed with the
standard curves (Figure 2-10 on page 45).
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Calibration Charts
The Calibx worksheet displays charts for each analyte in one group view. You can
also scroll down to see the lot information and other parameters.

Figure 2-10 Calib6 worksheet after fitted standard curves are calculated
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You can view the charts in a logarithmic, semilogarithmic, or linear scale. Choose
a scaling method from the scale pop-up menu (Figure 2-11 below).

Figure 2-11 Choosing the scaling method

The maximum value for the y-axis is 100,000 to allow for a five-decade log scale.
The software automatically scales the x-axis based on the lowest non-zero
concentration value and the highest concentration value.

The equation of each graph is displayed below the graph. The equation for each
model and the variables used are shown in Table 2-2.

Table 2-2 Curve-fitting equations and variable definitions

Model Log-Log 4-Parameter Logistic

Equation logy = a • logx + b

Variables x = concentration x = concentration

y = MFI y = MFI

a = slope a = y-value at the asymptote at low values of x

b = y-intercept b = slope

c = midpoint between a and d

d = y-value at the asymptote at high values of x
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Use the scroll bar to view the calculations for each sample: concentration, MFI, and
Calc Curve Fit. Continue scrolling to view information from the Calibration Setup
window and the gating parameters.

Click the Single View button or click each StdCurve tab at the bottom of the work-
sheet to view each chart in more detail (Figure 2-12).

Figure 2-12 StdCurvex worksheet (Single View) for the 4-Parameter Logistic model

The Single View displays the calculated concentrations (Calc Conc) and percent
difference (%Diff) from actual values for each calibration curve. When there is more
than one replicate, the standard deviation (Std Dev) and percent coefficient of
variation (%CV) are also displayed. Use the Show Detail pop-up menu to show or
hide details about the samples (Figure 2-13 on page 48).
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Figure 2-13 Details of StdCurvex worksheet

Replicate points are displayed on the single charts (StdCurvex worksheet,
Figure 2-14), but not on the group chart (Calibx worksheet, Figure 2-10 on
page 45).

Figure 2-14 StdCurvex worksheet (Single View) with replicates

On the single chart, when you choose to Show Detail, each replicate point and the
average of all the replicates are plotted. The values plotted on the group chart are
the average of the replicates.
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To view the group chart again, click the Group View button.

The Four-Parameter Logistic model supports descending (inhibition) curves as well
as ascending curves (Figure 2-15). Individual analytes within an assay may have
either ascending or descending curves.

Figure 2-15 StdCurvex worksheet (Single View) of descending curve
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Analyzing Sample Files

After you have made the calibration curves, you analyze the sample files. When new
calibration files are entered, existing sample results are cleared.

NOTE If you attempt to analyze results before completing the calibration curve
fitting procedure, no sample results (concentrations) will be shown.

1 Click the Analyze Sample Files button (     ) on the Quantitative toolbar.

An alert notifies you that this process might take a few minutes.

2 Click OK.

3 Locate and select the first sample file; click Open.

BD CBA software:

• copies the filenames to the Results worksheet

• analyzes each file

• reports the MFI for each analyte

• calculates tube and sample concentrations

An alert notifies you when the process is complete.

4 Click OK.

The Results worksheet (Figure 2-16 on page 51) displays the MFI, tube and
sample concentration for each analyte, and the dilution factor for each sample.
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Figure 2-16 Results worksheet

5 Enter a new dilution factor in Column E, if necessary.

The dilution factor is set to 1 by default. If you change the dilution factor
and want it copied down the column to all samples, select the Copy Down
checkbox. When you enter a new dilution factor, the values in the Sample
column are adjusted accordingly – the dilution factor is multiplied by the Tube
concentration value.

If a sample’s MFI result is outside the range of the standard curve for an analyte,
BD CBA software notes this in the comments section of the Results worksheet.
(See Range of Estimated Concentrations on page 33.) You should rerun the test
using a different dilution.

• If the MFI result is below the standard curve range, the sample is too dilute.

• If the result is above the standard curve range, the sample is too concentrated.
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Analyzing Replicates
BD CBA software analyzes and provides statistics for replicate samples
(Figure 2-17). Replicates are identified by identical SampleID field values. The
sample ID can be entered at the time of acquisition or edited within BD CBA
software. Samples need not have the same number of replicates as other samples
in the batch.

Click the Process Replicates button to start a macro that sorts the result rows by the
SampleID, then calculates the statistics and places them on the last row for each
group of replicates.

NOTE The rows of grouped replicates have alternating colors of gray and white.

Figure 2-17 Results worksheet with replicate results
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Formatting the Results Worksheet

1 Click the Format button on the Results worksheet.

The Format Options dialog box appears (Figure 2-18).

Figure 2-18 Format Option dialog box

2 Select the options you want to apply to the Results worksheet.

• Show & Size Columns—Select the columns that you want to appear on the
Results worksheet. Resize the selected columns, if necessary.

• Show & Size Statistic Columns—Select the Show Statistics Columns check-
box if you want these columns (Mean, StdDev, and %CV) to appear on
the Results worksheet. Resize the columns, if necessary.

• Page Setup—Select the number of analytes to print on each page from the
dropdown menu. BD CBA software calculates and displays the Samples
per page and %Normal Size, and sets the page orientation.

NOTE This automated pagination feature gives a best guess for how the report
should be formatted based on the default values. If you change any settings,
you might want to use Excel’s Print Preview function to view reports before
printing them to make sure some data does not overflow page boundaries. You
can make adjustments to column widths and use Excel’s scaling factor in Page
Setup to fit all the data within page boundaries.

• Click the Use Defaults button to set the options to what they were at
installation. See Figure 2-18 for default values.
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Deleting a Sample Row
You can delete a sample row from the Results worksheet. You cannot delete a
sample row after replicates have been processed. If you delete a row and want to
get it back, you must reanalyze the files using the Analyze Sample Files button on
the Quantitative toolbar.

1 To delete a sample row, enter “d” in Column A of the Results worksheet.
The row is highlighted and a confirmation dialog box appears.

2 Click Yes to delete the row.

Using the PlateView Worksheets
The PlateView worksheets display selected results for up to five microtiter plates
per experiment. When you use a 96-well plate format, the software automatically
displays the file name and concentration value in each well for the first analyte.
To change the information displayed in the wells, check the desired checkboxes
then select an analyte from the dropdown menu or click the Refresh button.
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Figure 2-19 PlateView sheet color coded by concentration value

• Results to Report—Select an analyte from the list. The information in each well
is automatically updated.

NOTE If the Tubes radio button is selected on the Calibration Setup dialog, an
error message displays when you select an analyte. 

• File Name—Check this box to display the FCS file name in row one of each
well.

• Sample ID—Check this box to display the sample ID in row two of each well.

• Concentration—Check this box to display the concentration value in row three
of each well. 

NOTE Concentration units are displayed in the Units field of the report header.

• MFI—Check this box to display the MFI in row four of each well.

• Well ID—Check this box to display the well ID in row one of each well.

• Color Wells Displays the Color Code Wells dialog for specifying how wells
should be colored.

• Refresh —refreshes the view after you make changes to the checkboxes or the
color palette.
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Color Coding Wells in PlateView
The Color Code Wells dialog lets you choose from three options for coloring wells
on the PlateView sheets.

• Don’t color code —wells are not colored. This is the default value.

• By Concentration Range —wells are colored according to which range the
concentration value falls within. Ten default ranges are provided, but you can
change any of these values, if desired. Click the Use Defaults button to revert to
the default ranges and colors. 

• By Std Dev from Mean —wells are colored depending on how many standard
deviations the concentration is from the mean. BD CBA software automatically
calculates the mean and standard deviation values for a plate. These cannot be
edited by the user.  

• Exclude Standards —Calibration standards are excluded from the mean and
standard deviation calculations by default. If you want the standards included
in the calculation, uncheck the “Exclude Standards” checkbox. If standards are
excluded, the wells containing standard results are not colored.

You can temporarily change a color by clicking a colored square and selecting
Autoshape from the Format menu (see Figure x-x). Alternatively, you can
permanently change the colors by editing the color palette on the Preferences
sheet.

Out-of-range results are displayed in red font on a white background.
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Figure 2-20 PlateView sheet color coded by standard deviation
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Copying Results
You can copy results from PlateView columns AA through AF to another Excel
spreadhsheet to do further analysis, such as display histograms or calculate statis-
tics. The results are in listed in alphabetical order by plate and well ID.

Reporting Quantitative Results

BD CBA software offers a variety of ways to report and save your results. You can
customize report headers and footers and print the reports of interest. You can save
one or more worksheets separately or save the entire workbook.

Setting Printing Options
You can customize report headers and footers to print additional information such
as the name of your institution, lab director, and other site-specific information. You
can also change the default paper size from US Letter to A4, for example.

There are two ways to customize reports.

• Page Setup dialog box under the File menu—sets printing options for the
current worksheet only.

• Print Reports button on the Quantitative toolbar—sets printing options for the
entire workbook.

NOTE To make your changes become the default options for the software, save
your workbook as a template as described on page 63.

Customizing Worksheets

1 Select Page Setup from the File menu.

2 Click the Header/Footer tab to display the setup options (Figure 2-19).
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Figure 2-19 Page Setup dialog box

3 Change the header, if needed.

• Choose a header from the Header pull-down menu, or select Custom
Header to create your own.

• Click OK.

4 Change the footer, if needed.

• Choose a footer from the Footer pull-down menu, or select Custom Footer
to create your own.

• Click OK.

5 Select Options to change the paper size.

A printer setup dialog box appears where you can select the paper size.

NOTE In Windows, click the Page tab in the Page Setup dialog box and choose
the required option from the Paper size drop-down menu.

6 Click OK in the Page Setup dialog box.

7 Choose Save from the File menu.

8 Enter a name for the worksheet; click Save.

Your changes are saved only with the current worksheet. To make changes to
all sheets in the workbook, see the following section.
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Printing Reports
Use the Print Reports button to put the experiment name on all selected reports at
the same time. Changes made here will also be reflected in the Page Setup dialog
box.

NOTE You cannot change the default paper size for all worksheets in a
workbook at once.

1 Click the Print Reports button (     ) on the Quantitative toolbar.

The Print Reports dialog box appears (Figure 2-20 below).

Figure 2-20 Print dialog for quantitative reports
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2 Select all applicable options.

• Standard Curves (Group View)—Select the appropriate calibration chart
(Calib4, Calib6, or Calib8); then select whether to print the Full Report
(charts and additional information) or the Charts only (Figure 2-10 on
page 45).

• Standard Curves (Single View)—Select whether to print the calibration
chart single view (Figure 2-12 on page 47) for the standard curves for each
analyte. Both the charts and the additional information are printed.

• Other Reports —Select whether to print the RawData worksheet
(Figure 2-6 on page 32), the Curve-Fitting Model (either 4-Parameter
Logistic or Log-Log), and the Results worksheet (Figure 2-16 on page 51).

• Format —Displays the Format Options dialog (Figure 2-18 on page 53).

• PlateView —Select one or more plates and one or more analytes
(Analyte1 – Analyte8 checkboxes) from the list. The results reported in
each well depend on which “Results to Report” checkboxes you checked
on each of the PlateView sheets.

NOTE If the Tubes radio button is selected on the Calibration Setup dialog, all
checkboxes in the PlateView group are gray and disabled.

• Report Header & Footer—To make changes to the header and footer for
all selected reports, click the “Enter a common header and footer…” radio
button. Change the appropriate field. Any changes you make here will be
reflected in the Page Setup dialog box (Figure 2-19 on page 55).

• Copies —Enter the number of copies.

• Paper Size—Select Letter or A4 paper size.

3 Click Print.
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Saving Reports
Saving only the worksheets you are interested in uses less disk space than saving the
entire workbook.

NOTE You cannot reanalyze the data once it is saved in this format. Some
interactive functionality is also lost.

1 Click the Save Reports button (     ) on the Quantitative toolbar.

The Save Reports dialog box appears.

2 Select the reports you want to save; click Save.

An alert appears. Click Save to dismiss the alert, then OK to dismiss the next
alert.

3 Enter a filename and specify the folder location for the new workbook;
click Save.

4 Click OK to return to the active worksheet.
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Saving the Complete Workbook

The workbook includes all the worksheets. Saving the entire workbook takes up
more disk space than saving just specific reports; however, you can reanalyze the
data after it is saved.

1 Choose Save As from the File menu.

2 Enter a filename for the new workbook; click Save.

Saving Templates

Workbooks and worksheets can be converted into templates that can be used
repeatedly as a master for similar experiments (eg, for beads with the same lot
number). When you open a template, a copy of the document is created and
opened, leaving the original unchanged.

Creating Templates on a Macintosh

1 Find the folder where the workbook or worksheet is kept.

2 Click the file icon once.

The icon is highlighted.

3 Choose Get Info from the File menu.

4 In the lower-right corner of the Info window that appears, select the Stationery
Pad checkbox.

5 Close the Info window.

The file icon changes into a Stationery Pad (template) icon.

NOTE If you are using a Macintosh with OS X, the icon does not change.

Creating Templates in Windows

1 Find the folder where the workbook or worksheet is kept.

2 Click the filename once.

The filename is now able to be edited.

3 Change the file extension from .xls to .xlt.

The file icon changes into a template icon.
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3

Qualitative Analysis
The following topics are covered in this section:

• Launching BD CBA Software

• Analyzing Files

• Changing Display Options

• Reporting Qualitative Results
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Launching BD CBA Software

The BD CBA Isotype Analysis workbook is used for qualitative analysis.

1 Double-click the BD CBA Isotype Analysis workbook icon.

Microsoft Excel software launches. A dialog box might appear to alert you that
the document contains macros.

2 If the dialog box appears, click the Enable Macros button.

BD CBA software launches and the Mouse Isotyping home screen appears.
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Analyzing Files

1 Click Analyze on the Mouse Isotyping Home screen.

The Qualitative tool bar and a blank Results worksheet appear (Figure 3-1).

Figure 3-1 Qualitative tool bar and Results worksheet

NOTE In Microsoft Excel software, the name of the active worksheet appears
as a tab at the bottom of the window.

The tool bar appears free-floating. You can move it or drag it to the tool bar
area above the worksheet. Figure 3-2 and Table 3-1 on page 68 describe the
functions of the buttons on the tool bar.
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Figure 3-2 BD CBA Isotype tool bar

Table 3-1 Qualitative tool bar buttons

Calib Setup - displays a dialog box in which you can select different
parameters to process.

Process Samples—prompts you to identify the folder containing the FCS data
files. BD CBA software then calculates MFIs for FL1 and FL2. Positive results
are displayed in bold red type.

Display Options—displays a dialog box in which you can select on-screen and
print formatting options.

Print Report—displays a dialog box in which you select the number of reports
to print and enter the header and footer.

Save Report—saves a copy of the report.

Home Screen—returns to the home screen.

Help—displays online help for Qualitative analysis.

2 Click the Process Samples button (     ) on the Qualitative tool bar.

An alert notifies you that this process might take a few minutes.

3 Click OK.

4 Locate and select the first file to analyze.

The first file in the folder, listed alphabetically by name, must be the
blank—a non-stained sample (a sample with beads, a reporter, and no
analytes). All files in this folder will be analyzed.
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5 Click Open.

The filenames are listed in Column C.

BD CBA software:

• gates on FSC, SSC, and FL3

• calculates the MFI for FL1 and FL2

• reports the MFIs in the λ (FL1) and κ (FL2) columns

• scans for positive results based on the cutoff value

• displays all results, with positive results in bold, red type

A beep sounds when the process is complete and the Results worksheet is
displayed (Figure 3-3).

Figure 3-3 Results worksheet

The information for the blank bead is in the first row, which is highlighted in
yellow. The cutoff value for the MFI of a particular analyte, which determines
whether a result is positive or negative, is the MFI of the blank bead multiplied
by the negative threshold. Positive results are displayed in bold red type.

NOTE You might have to adjust the threshold levels for FSC and SSC if the data
was collected in linear mode. For more information, see Gating Issues on page 83.
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Modifying the Results Worksheet

You can make limited modifications to the worksheet.

• Negative Threshold Value—This value, displayed in cell E1 on the worksheet, is
3 by default.

To change the value, select it and enter a new value. BD CBA software adjusts
the formulas, recalculates the qualitative results, scans for positive results, and
displays them in bold red type.

NOTE For best results, we recommend that the Negative Threshold Value
be ≥3. This provides sufficient resolution to be confident of positive results.
In most cases, MFIs of positive results will be substantially higher than this.
We recommend that you evaluate the appropriate setting of this threshold
based on the MFI values of your positive samples.

• Dilution Factor—The dilution factor is set to 1 by default.

If you change the dilution factor and want it to be copied down the column
to all samples, use the Display Options dialog box (see Changing Display
Options on page 72).

You must press the Enter, Return, or Tab key to copy the dilution factor
down the column.

• Comments—Enter text comments in the Comments column (AW) of the report.
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Changing Parameters to Process

1 Click the Calib Setup button (     ) on the Qualitative tool bar.

The Calibration Setup dialog box appears (Figure 3-4).

Figure 3-4 Calibration Setup dialog box for Qualitative Analysis

NOTE Some fields are disabled because they do not apply to qualitative analysis.

Select the parameter order in which the instrument acquired and saved the
data. For example, if the instrument saved data in the following order: FSC,
SSC, FL2, and FL1, select P1 for FSC, P2 for SSC, P3 for FL2, and P4 for FL1.

NOTE If you are not sure of the parameter order, you can open the FCS file in
Excel. The parameters are listed in the order in which they were acquired and
saved. Refer to Reading the FCS File Header on page 89 for more information.

Click Use Defaults to set the values to the BD default values (P1, P2, P3, P4, P5).

2 Click OK

3 Change the labels (row 2) on the Results7 worksheet to match the new
parameter order.
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Changing Display Options

1 Click the Display Options button (     ) on the Qualitative tool bar.

The Display Options dialog box appears (Figure 3-5).

Figure 3-5 Display Options dialog box

2 Select the required options.

• Dilution Factor—If you change the dilution factor on the worksheet and
want it to be copied down the column to all samples, click the “Copy
Down Column” radio button. If you do not want it copied down the col-
umn to all samples, click the “Don’t Copy Down Column” radio button.

• Choose whether to show or hide the Filename (in column C), the MFI
Values (in columns F, I, L, O, …), and the POS/NEG Results (in columns
G, J, M, P, …).

• Click the Use Defaults button to set the options to what they were at
installation.

3 Click OK.
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Reporting Qualitative Results

BD CBA software offers a variety of ways to report and save the results of your
analysis. You can customize report headers and footers and print the report using
several different formats.

Setting Printing Options
You can customize the report headers and footers to print additional information
such as the name of your institution, lab director, and other site-specific
information. You can also change the default paper size from US Letter to A4, for
example.

There are two ways to customize reports.

• Page Setup dialog box under the File menu—sets general printing options
including the paper size.

• Print Reports button on the Qualitative tool bar—sets custom headers and
footers only.

NOTE To make your changes the default options for the software, save your
workbook as a template as described on page 63.

1 Select Page Setup from the File menu.

2 Click the Header/Footer tab to display the setup options (Figure 3-5 below).

Figure 3-5 Page Setup dialog box
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3 Change the header, if needed.

• Choose a header from the Header pull-down menu or select Custom
Header to create your own.

• Click OK.

4 Change the footer, if needed.

• Choose a footer from the Footer pull-down menu or select Custom
Footer to create your own.

• Click OK.

5 Select Options to change the paper size.

A printer setup dialog box appears where you can select the paper size.

NOTE In Windows, click the Page tab in the Page Setup dialog box and choose
the required option from the Paper size drop-down menu.

6 Click OK in the Page Setup dialog box.

7 Choose Save from the File menu.

8 Enter a name for the worksheet; click Save.

Your changes are saved with the current worksheet. To make yourworksheet
into a template, see page 63.

Customizing Headers and Footers

Use the Print Reports button to easily enter custom headers and footers. Changes
made here will also be reflected in the Page Setup dialog box.

1 Set the number of columns in the Display Options dialog box (Figure 3-4 on
page 71).

Only the columns currently shown will be printed.

2 Click the Print Reports button (     ) on the Qualitative tool bar.

The Print Report dialog box appears.
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3 Enter the header and footer.

To make changes to the header and footer of the Results worksheet, change
the appropriate field in this dialog box. Any changes you make here will be
reflected in the Page Setup dialog box (Figure 3-5 on page 72).

4 Enter the number of copies, then click Print.

Saving Results
Saving only the results uses less disk space than saving the entire workbook.

NOTE You cannot reanalyze the data once it is saved in this format.

1 Click the Save Reports button (     ) on the Qualitative tool bar.

2 Enter a filename for the new workbook, then click Save.

An alert appears telling you where the results have been saved.

3 Click OK.

Saving the Complete Workbook

The workbook includes all the worksheets. Saving the entire workbook takes up
more disk space than saving just specific results; however, you can reanalyze the
data once it is saved in this format.

1 Choose Save As from the File menu.

2 Enter a filename for the new workbook; then click Save.

3 Click OK.

The new workbook is saved.
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4

Troubleshooting
The following topics are covered in this section:

• Installation and Startup Errors

• General Software Issues

• Microsoft Excel 98–Specific Errors

• Gating Issues

• Curve Fitting Issues

• Reading the FCS File Header
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Use this list of common observations and solutions for self-guided troubleshooting.
If you cannot solve the problem, contact your local BD Biosciences service representative.

Installation and Startup Errors

Most BD CBA software installation errors occur because the Microsoft Excel
Solver Add-In, the BD CBA Add-In, or both have been incorrectly installed.

If you are having problems starting up the software, verify the following:

• The BD CBA Add-In and the Solver Add-In have been installed and are in
the correct locations.

- For Excel 98, add-ins are located in the Microsoft Office 98
Office:Excel Add-ins folder.

- For Excel 2001, add-ins are located in the Microsoft Office 2001:
Office:Add-ins folder.

- For Excel X, add-ins are located in the Microsoft Office:Office:
Add-ins folder.

- For Excel 2000 (Windows), add-ins are located in the Microsoft
Office:Office:Library folder. See Figure 4-2 on page 79.

• There is only one version of Microsoft Excel installed.

- Remove all but one version of Microsoft Excel, uninstall the BD CBA
software, the reinstall the BD CBA software.

• The BD CBA Add-In has been activated in the Add-Ins dialog box in
Microsoft Excel.

To activate add-ins, launch Microsoft Excel, choose Add-Ins from the Tools
menu, click the checkbox to select the BD CBA Add-In, and then click OK
(see Figure 4-1 on page 79).
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Figure 4-1 Activating add-ins

• The BD CBA software folder and the Microsoft Office folder are in the same
disk partition on the hard disk.

Figure 4-2 Add-in locations for Excel 2000 (Windows)
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General Software Issues

Issue Possible Cause Recommended Action

Error message on opening a BD CBA Add-In 1 Click No.
BD CBA workbook: improperly installed
“The workbook you If you click Yes, you will
opened contains automatic receive a series of
links to information in approximately 30 error
another workbook. Do you messages.
want to update this
workbook with changes 2 Reinstall BD CBA software.
made to the other
workbook?”

Error message relating to Insufficient memory Increase the memory allocation as
memory or system crash allocated to Microsoft described on page 17.
when opening BD CBA Excel
software

Error message after Files improperly named Rename files so filename contains
calculating MFIs: “Not an with only numeric at least one alphabetic character.
FCS file.” characters

Non-FCS files selected Make sure only FCS files are in
the specified folder. See Identifying
Calibration Files on page 30.

Problems with the toolbar Software corrupted Delete the toolbar; then reinstall
(eg, incorrect labels or BD CBA software.
incorrect procedures
execute when you select a
tool) 1 Launch Microsoft Excel.

2 Select Toolbars from the View
menu.

3 Select BD CBA Quantitative
Analysis or BD CBA
Qualitative Analysis; then click
Delete.

4 Click OK.

5 Quit Microsoft Excel.

6 Reinstall BD CBA software.
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Microsoft Excel 98–Specific Errors

Issue Possible Cause Recommended Action

Error message: “The Visual Missing file Locate the Visual Basic for
Basic Editor could not be Applications file. Make sure that
loaded.” it is in the following location:

Microsoft Office:Office.

If you cannot find it, reinstall
Microsoft Excel.

Error message: “Error in Software error Reinstall Microsoft Excel.
loading DLL.”

Compile errors Missing Solver Add-In Install the add-in as described on
page 78.

Missing file Locate the VBA Object Library
file. Make sure that it is in the
following location:
Microsoft Office:Office.

If you cannot find it, reinstall
Microsoft Excel.

Unable to find project or Locate the BD CBA Add-In file
libraries Make sure that it is in the

following location:
Microsoft Office:Office:Excel
Add-Ins.

If you cannot find it, reinstall
BD CBA software.
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Microsoft Excel 98–Specific Errors

Issue (continued) Possible Cause Recommended Action (continued)

Error message: “The Missing file Locate the VBA Localization
language DLL ‘VBA Library (1) file. Make sure that it
Localization Library (1)’ is in the following location:
could not be found.” Microsoft Office:Office.

If you cannot find it, reinstall
Microsoft Excel.

Files deleted or moved Locate the Visual Basic for
from their originally Applications, VBA Localization
installed locations Library, and VBA Object Library

files. Make sure that they are in
the following location:
Microsoft Office:Office.

If you cannot find them, reinstall
Microsoft Excel.

Not enough free memory Allocate more memory to the
to load the libraries Microsoft Excel application. See

page 17 for instructions.

Error message: “An error Files deleted or moved Locate the Visual Basic for
occurred initializing the from their originally Applications, VBA Localization
VBA libraries (8).” installed locations Library, and VBA Object Library

files. Make sure that they are in
the following location: Microsoft
Office: Office.

If you cannot find them, reinstall
Microsoft Excel.

Not enough free memory Allocate more memory to the
to load the libraries Microsoft Excel application. See

page 17 for instructions.
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Gating Issues

Occasionally, the gating algorithm might not find all the singlet and bead
populations in a file. Gating one file at a time is useful in determining why a
single file fails the gating algorithm. Adjust the gating parameters using the Set
Gating Parameters option; then reprocess the file to find parameters that better
fit your data set.

1 Choose Gate One File from the BD CBA menu.

The Calc worksheet is displayed.

Use this worksheet to gate one file at a time to test the gating parameters
you choose in the Set Gating Parameters dialog box. The worksheet
displays the following information:
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• gate settings

• events within gates

• histograms for FSC, SSC, FL3, and 1–8 reporters in FL1 or FL2

• event counts and MFIs for each bead size

• gate markers for FSC, SSC, and each analyte

2 If necessary, change the Reporter Antibody information.

3 Select Analyze one on the Calc worksheet; then select the file for which you
might want to adjust the settings.

4 Review the data and plots presented for the selected file.

5 Choose Set Gating Parameters from the BD CBA menu.

The Set Gating Parameters dialog box (Figure 4-3 on page 84) lets you
change the gating parameters to find more suitable settings for your data.
You can change these settings and reanalyze the files that failed.
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Figure 4-3 Set Gating Parameters dialog box

• TFactor—a percentage of events (expressed as a decimal)

• Max—maximum number of iterations that will be performed to find
the threshold

• Used—number of actual iterations used to find the threshold

• Step—amount to raise or lower the threshold level at each iteration

• TotEvents—total number of events

• vSizes—number of bead sizes in mix

• GatedEvents—number of events in the FSC/SSC (singlet) gate

• vSubset—number of analytes for this bead size

• Iter—current iteration number, beginning with 1

• FSC/SSC Peak Width—number of channels to the left and right of the
FSC and SSC peaks (used to set the singlet gate)

• Channels to Exclude when Gating—number of channels from the low
and high end of the scale to exclude for purposes of gating.

6 Change one or more settings (see Table 4-1 on page 86).
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Table 4-1 Gating Errors

Error Message Possible Solutions

Expected n FSC peaks; found n+1. Raise the FSC threshold factor (TFactor).

Expected n FSC peaks; found n–1. Lower the FSC TFactor.

Expected n SSC peaks; found n+1. Raise the SSC TFactor.

Expected n SSC peaks; found n–1. Lower the SSC TFactor.

Expected n FL3 peaks; found n+1. Raise the FL3 TFactor.

Lower the FL3 TFactor.

Increase the number of iterations (Max).

Expected n FL3 peaks; found n–1. Lower the FL3 TFactor.

Raise the FL3 TFactor.

Increase the Max.

Left/right FSC gate markers are not Raise the FSC TFactor.
evenly paired. Lower the FSC TFactor.

Left/right SSC gate markers are not Raise the SSC TFactor.
evenly paired. Lower the SSC TFactor.

Left/right FL3 gate markers are not Raise the FL3 TFactor.
evenly paired. Lower the FL3 TFactor.

Unable to set gating threshold on FSC. Threshold dropped to 1. Raise FSC TFactor.

Unable to set gating threshold on SSC. Threshold dropped to 1. Raise SSC TFactor.

Unable to set gating threshold on FL3. Threshold dropped to 1. Raise FL3 TFactor.

Wrong number of bead sizes. Please Make sure you specify the correct number of
check calibration settings. bead sizes and analytes per size in the

Calibration Setup dialog box.

7 Click the “Do One” button again to examine how the changes you made
influenced the fit.

8 Repeat steps 6 and 7 as needed.

9 Once you find settings that work for the files in question, reanalyze all your
data files using the adjusted settings.

Return to the RawData worksheet and click the Update StdCurves button
to recalculate the curves.

86



Chapter 4: Troubleshooting

Curve Fitting Issues

The 4-Parameter Logistic curve fitting model might not automatically be able to
fit a good curve to your data, or it might not be able to fit a curve at all. Use the
following suggestions to help get a better fit.

• Be sure you have at least four data points and a zero calibration value (five
points minimum) when using the 4-Parameter Logistic Model.

This model requires at least four data points in addition to the zero
calibration value. An error message is displayed if fewer than 5 data points
are found; however, BD CBA will still attempt to fit a curve to the data.

• Select a different weighting factor.

If most of the data points in a calibration curve fall below 1,000, a different
weighting factor might yield a better fit. See Refitting Curves on page 88 for
instructions.

• Modify your data set.

If one data point is clearly an outlier (noticably outside the curve compared
to other points), do not use that calibration file. Redo the analysis and
curve-fitting steps.

• Use the Log-Log model.

• Repeat the run.

If a solution cannot be found after 100 iterations, an error message
appears. If this occurs, click Stop.
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Refitting Curves
If most of the calibration points are located on the low or high end of the curve,
the 4-Parameter Logistic model might not be able to fit a curve to the data, or the
curve it fits might not be adequate. BD CBA software provides three weighting
functions to adjust for this condition.

1 Click the Logistic Model tab at the bottom of the Microsoft Excel
worksheet window.

You might have to scroll to the right to see the tab.

2 Click a Refit Curve button.

The Curve-Fitting Options dialog box appears.

3 Select a weighting factor.

4 Select whether to refit all curves or only one curve.

The default is the curve at which you are looking. You can choose another
curve from the pull-down menu.

5 Click Refit.

This changes the curve-fitting formulas using the new weighting factor and
refits the selected curve(s).
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Reading the FCS File Header

If you are unsure of the order in which parameters were saved in an FCS file, you
can use Excel to read the text section of the FCS file.

1 Open Excel.

2 Select Open from the File menu. Select All Files from the Files of type drop-
down menu.

3 Locate the FCS file and click Open. Excel displays the Text Import Wizard
(Figure 4-4).

Figure 4-4 Text Import Wizard

4 Use the horizontal scroll bars to scroll across the first row of the file. The
HEADER section of the FCS file contains the FCS version number and the
offsets for beginning and ending data.

The TEXT section, which follows the HEADER, is composed of keywords
and their values, which are separated by a special character such as a
backslash or an exclamation point (Figure 4-5 on page 90).

5 To find the order of the parameters, look for the keywords $P1N through
$P5N. The value following each keyword is the label for the parameter. In
Figure 4-5, the label for the first parameter ($P1N) is FL1 LOG.
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Figure 4-5 Scroll to locate parameters
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